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Abstract

This paper proposed research on wind computation fluid dynamics(CFD) analysis and visualization in scientific computing facing to
OSG in order to obtain numerical result of aerodynamic characteristics stimulated by windmill and to display vivid and direct 3-D
effect for easy observation experiment. This paper applied CFX module in ANSYS Workbench software to conduct CFD analysis
and calculation of windmill through computer graphic display technology based on CFD principle and realize numerical stimulation
of aerodynamic characteristics of windmill. Then the research on visualization in scientific computing of aerodynamic characteristics
of windmill was realized combining with OSG software that face to virtual display technology
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1 Introduction

Various countries in the world are searching for new
energy shortcut for the shortage of world energy [1].
Therefore, wind energy becomes an area, to which many
countries pay high attention. For large volume and super
high large wind driven generator, wind load is a quite
important control load. However, problems such as wind
pressure distribution and smooth interference usually
cannot solved by normative solution pattern when
important parameter of wind load is mentioned.
Traditional action is to put entity or integration model
into wind tunnel to conduct analysis and stimulation
experiment of relative data so that obtain relative wind
load experimental data result [2], which is used for design
and improvement data of relative entity model. For
instance, when airplane and car is done improved design,
we usually extract relative experimental data in wind
tunnel experiment [3]. However, wind tunnel has
drawbacks of insufficient scale effect, high cost, long
period and bad flexibility.

Scientific visualization has become the important
research direction of current computation graphics [4].
People use traditional original visualization technology
method to count or draw chart on scientific analysis data
for observation experiment [5]. We aims to display 3-D
flow field result figure generated by numerical simulation
of aerodynamics characteristics of windmill in vivid and
direct effect, make users observe the process when wind
blowing over windmill more directly, increase
perceptibility of windmill flow field and improve
scientific research level of windmill. Therefore, we
introduce “numerical wind tunnel” by combination of
software and hardware for conducting numerical
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simulation analysis technology of aerodynamics
characteristics of relative model [6]. Car virtual wind
tunnel research of Jili University and virtual wind tunnel
research on aircraft of Beijing University of Aeronautics
and Astronautics [7] have problem of few application
cases and few departments that can provide 3-D data.
Therefore, this paper explored and studied how to realize
application of visualization in scientific computing more
deeply.

2 Overview of computation fluid dynamics

Computation fluid dynamics (CFD) refers to systematic
analysis and research on physical phenomenon such as
heat conduction and fluid flow by computer numerical
analysis and calculation and graphics display technology
[8]. CFD is to conduct numerical simulation on fluid flow
under the control of three flow basic equation [9].
Fundamental physical quantity in various position within
fluid field and their basic situation of changing over time
can be derived from these numerical simulation. CFD can
display simulation result on computer screen by specific
calculation means. In addition, it can also observe
detailed effect in flow field to display flow scene directly
and vividly.

Procedures of numerical simulation on fluid flow
characteristics by CFD are as follows. First, a
mathematical model that reflects problem nature should
be set up. That is, to build up integro-differential equation
that reflects the relationship between quantities of
problem with definite condition and three conservation
equation with their definite condition which is easy for
calculation simulation solution. Then numerical discrete
optimization method should be constructed as the core of
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CFD, which is easy for research and analysis on CFD.
Moreover, compilation and calculation are carried out. It
includes division of computer network, import of initial
conditions, boundary conditions, setting of control
parameter, etc. At last, the result is conducted refine
processing to obtain a high quality of display result.

The practical solution process of CFD is very
complicated. The application of CFD is also complex.
Therefore, many users select CFD commercial software.
The structure of this commercial CFD software mainly
includes pre-processing, solution and post processing.

3 Pre-processing and data conversion of 3-d geometric
model of windmill

3.1 PREPROCESSING OF 3-D GEOMETRIC MODEL
OF WINDMILL

Wind turbine blade and overall stand is selected to
analyse and calculate and conduct numerical simulation
research of aerodynamic characteristics of windmill.

3.1.1 Construction of Windmill 3-D Model

Windmill whose rated power is 1.5 megawatt designed
by some enterprise was selected. And UG software
produced by Siemens PLM Software Corporation was
used for windmill 3-D geometric modelling. Fig.1 is UG
windmill 3-D geometric model. Tower in tapered tubular
steel structure was made of low-alloy high tensile
structural steel Q 345. Hub centre is of 70 m high, 11 m/s
rated wind speed, 3.5 m/s cut-in wind speed, 25 m/s cut-
out wind speed and 3847 m2 swept area. CFX application
module in ANSYS-Workbench was selected to do one
way fluid-structure interaction analysis to realize
calculation process of numerical simulation of
aerodynamic characteristics of windmill because UG
software itself is hard to realize that process.

3.1.2 Realization of UG and ANSYS Software Data
Interface

UG is a software system of CAD and CAM that can
realize interaction function. After 3-D model design
software UG was used for constructing windmill 3-D
geometric model, is was done data conversion and then
applied into ANSYS-Workbench software to realize
numerical simulation of aerodynamic characteristics of
windmill. And IGES file format which is the sharing
common format of UG and ANSYS-Workbench. Their
characteristic was applied to read complete data from
different platform to realize standard of data interchange
between CAD and CAM system [10]. Thus, UG software
could be used for deriving 3-D geometric model of
windmill. Then it was derived into ANSYS-Workbench
to conduct windmill 3-D geometric reconstruction to
achieve  numerical  simulation of  aerodynamic
characteristics of windmill.
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FIGURE 1 3-D geometric model of UG windmill

3.2 DATA CONVERSION OF WINDMILL 3-D
GEOMETRIC MODEL FROM UG TO ANSY'S

We have pre-processed windmill geometric model and
realize interface function of data conversion of UG and
ANSYS. Therefore, we can directly do data conversion
on windmill 3-D geometric model into IGES file format
and then import it into ANSYS Workbench software to
do research on numerical simulation analysis of
aerodynamic characteristics of windmill.

IGES file derived from windmill 3-D geometric
model should be prepared before analysis. We selected
Start Menu, through the path “ALL Programe,
ANSYS14.0 > Workbench”, start ANSYS Workbench
module, open “fengjizhengti, igs” file in window of “File
> Import” path and select Geometry to conduct “Update”
geometric model load.

4 Application of CFD module from ANSYS software
in numerical simulation of aerodynamic
characteristics

Preparation of geometric file was basically fulfilled
through the previous work. Next, CFX module in
ANSYS software was applied to do numerical simulation
of aerodynamic characteristics of windmill. CFD
commercial software, which has regularity and
systematicness was needed to solve the problem because
CFD calculation involves allocation of computer software
and hardware and the complexity of problem. CFX was
constantly integrated the most advanced global physical
geometrical model and simulation solution algorithm for
ensuring the accuracy and stability of calculation result.
Meanwhile, finite volume method based on finite element
was also wused for ensuring basic conservation
characteristics and accuracy of numerical value [11].
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4.1 REALIZATION OF PREPROCESSING OF
WINDMILL 3-D GEOMETRIC MODEL IN CFX
MODULE OF ANSYS SOFTWARE

Pre-processing of 3-D geometric model mainly involves
functional operation in DesignModeler on the model that
has been imported to realize modelling process of
rotating field and external flow field.

FIGURE 2 windmill model of cylindrical rotating field

FIGURE 4 square external flow field of windmill after Boolean
calculation
First, we double clicked GeometryA2 module to
conduct windmill 3-D geometric model load to enter
DesignModeler analysis module and selected Meter unit
system in “unit” dialog box. Second, we constructed
cylindrical rotating field of windmill 3-D geometric
model through path “Create > Primitives > Cylinder”.
Fig.2 is windmill model of cylindrical rotating field. Then
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blade model was removed. We did Boolean calculation of
windmill 3-D geometric model through path “Create >
Primitives > Box”. We selected “Yes” order in Preserve
Tool Bodies for reservation of blade model. At last, after
rotating field setting, square external flow field was
constructed through path “Create > Primitives > Box”.
Then Boolean calculation was done again. Fig.3 is square
external flow field. Fig.4 is square external field after
Boolean calculation.

4.2 FLOW FIELD MESH DIVISION OF 3-D
GEOMETRIC MODEL OF WINDMILL

After pre-processing of 3-D geometric model of windmill
by ANSYS Workbench, we used Mesh module to divide
3-D geometric model mesh of windmill to generate the
needed calculation mesh.

First, we constructed Mesh module, dragged
GeometryA2 into MeshB2 and imported pre-processed
windmill 3-D geometric model into Mesh module. Then
we expanded path “Project > Model > Geometry” to
observe some Solid body. Windmill model was
suppressed and only the flow field was remained. Solid
body would show out X mark after suppression. Then we
revised Solver Preference value as CFX through path
“Project > Model (B3) > Mesh”. CFX-meshing under
Mesh was right clicked. At last, we realized the setting of
boundary condition by setting entrance of external flow
field, exit of reserve side of windmill, ground and part
surface of windmill stand. Meanwhile, some specific
network properties were set. At last, mesh model of
windmill flow field is generated as shown in Fig. 5.

FIGURE 5 Mesh model of windmill flow field
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FIGURE 6 load figure of rotating field and xternal flow field
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4.3 SETTING AND SOLUTION OF FLUID
ANALYSIS OF WINDMILL 3-D GEOMETRIC
MODEL

After division of windmill 3-D geometric model mesh,
we entered into fluid analysis setting including designing
boundary condition and properties of solver.

First, we set analysis category and imported divided
Mesh file into CFX-Pre for fluid calculation. Then CFX
module was generated automatically and connected. Then
rotating field and external fluid field were constructed. At
last, the relative boundary parameter condition was set.
Fig. 6 is the load figure of rotating field and external fluid
flow field after setting of relative parameters.

FIGURE 8 flow line of 3-D flow field removing windmill

We only need to do simple solver setting after
calculation of fluid and then solution result could be
achieved. Fig. 7 is windmill 3-D flow line after setting of
solver.
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Through application of CFX module in ANSYS
Workbench software, 3-D flow field figure removing
windmill can also be independently produced. Fig. 8 is
flow line of 3-D flow field removing windmill.

5 Conclusion

This paper mainly illustrated application and basic
knowledge of common commercial software in CFD in
order to study windmill CFD. Based on it, we pre-
processed windmill geometric model and realized
interface function of data conversion between UG and
ANSYS. Windmill 3-D geometric model constructed in
UG was directly conversed into IGES format and then
imported into ANSYSWorkbench software for study of
numerical simulation of aerodynamic characteristics of
windmill. IGES file derived from windmill 3-D
geometric model should be prepared before analysis. And
CFD module in ANSYS software was applied for
numerical simulation of aerodynamic characteristics of
windmill. CFX module can ensure accuracy and stability
of calculation result as well as basic conservation
characteristics and accuracy of numerical value. Pre-
processing of 3-D geometric model mainly involved
functional operation in DesignModeler on model that
have been imported to realize the modelling process of
rotating field and external flow field. Through pre-
processing of windmill 3-D geometric model by ANSYS
Workbench, we used Mesh module to divide the mesh of
windmill 3-D geometric model to generate the needed
calculation mesh. After division of windmill 3-D
geometric model mesh, we entered into fluid analysis
setting including designing boundary condition and
properties of solver. We only need to do simple solver
setting after calculation of fluid and then solution result
could be achieved. At last, the numerical simulation of
aerodynamic characteristics of windmill was achieved.
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